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The	Bridget	Riley	Power	Point	we	have	won’t	upload	the	notes	at	the	bottom	that	tell	you	about	the	
pictures,	so	if	you	would	like	that,	please	email	us	and	we	can	try	to	send	it	to	you	directly.	

	



Brigit	Riley	Project	–	Teacher	Time	Plan	
This	schedule	is	based	on	45	minute	long	periods	

	
Day	1	
1.		Introduce	Brigit	Riley	&	her	art		

• living	British	Artist	
• Op	art	
• focuses	on	movement,	depth,	play	of	light	
• while	mathematical	in	nature	-	she	does	not	think	about	math	at	all	when	creating	
• she	has	clear	intent	in	her	art	-	a	goal	she	is	trying	to	create	-	however,	it	may	morph	in	

the	process		
2.		Discuss	how	we	are	going	to	critique	each	other's	work	and	Riley's	art	

• "warm"	-	what	we	like	about	the	piece	
• "cool"	-	what	we	don't	particularly	like	
• "I	wonder"	-	things	we	might	change	if	we	created	the	art	

ex.		 I	wonder	what	it	would	look	like	if	she	used	blues	instead	of	reds.	
	 I	wonder	what	would	happen	if	she	didn't	overlap	the	circles.	

3.		Show	the	power	point	of	her	work	and	critique	her	work	using	the	warm/cool/I	wonder	model.	
4.		Remind	students	to	bring	computer	to	class	tomorrow	(or	to	pick	up	one	from	the	computer	lab).	
5.		Homework:		begin	thinking	about	what	they	may	want	to	create.	
	
Day	2		
1.		Show	the	YouTube	videos	of	Brigit	(warning	quality	is	poor	because	they	are	from	the	60's).	
2.		Talk	about	what	our	project	is	going	to	entail.	

• Time	frame	
• Hand	out	the	packet,	which	includes:	

a. Overview	
b. Rough	Draft	Directions	
c. Critique	of	Initial	Sketches	
d. From	Grapher/Desmos	to	Photoshop	
e. Rubric	

3.		If	time	permits,	begin	Grapher/Desmos	Trials	Worksheet.	
4.		Remind	students	to	bring	computer	to	class	tomorrow	(or	to	pick	up	one	from	the	computer	lab).	
5.		Homework:		begin	thinking	about	what	they	may	want	to	create.	
	
Day	3		
1.		Start	with	Grapher/Desmos	Trial	Worksheet		

• Try	to	get	students	to	recreate	the	drawings	using	minimal	equations	in	Grapher/Desmos.			
2.		When	they	finish	with	the	trials,	allow	students	to	experiment	with	the	program.	
3.		Remind	students	that	there	is	no	need	to	bring	computer	to	class	for	Day	4.	
4.		Homework:		Come	to	class	prepared	with	2	to	3	sketches	of	possible	projects	using	the	Rough	Draft	

Sheet	in	their	packet.			
			
Day	4			
1.		Divide	students	into	groups	of	three	or	more	to	critique	each	other's	work.	



• Remind	students	that	they	are	to	use	the	"warms"	and	"I	wonder"	but	that	we	are	going	to	
leave	off	the	"cools"	at	this	juncture.	

• One	member	of	the	group	will	be	the	scribe	for	the	first	artist.		They	will	write	down	what	the	
artist	says	and	then	what	their	group	mates	say	on	to	the	Critique	Sheet.	

• One	artist	will	present	one	of	their	sketches.		They	will	talk	about	their	intent/vision	behind	
the	piece	as	well	as	the	mathematics	they	think	they	may	need.			

• The	group	will	get	a	chance	to	respond	to	the	sketch	using	"warms"	and	"I	wonders."		The	
scribe	will	continue	to	write	down	what	is	said	allowing	the	artist	to	listen.			

• When	the	sheet	is	filled	out	(1	per	sketch)	for	the	first	artist's	sketch	then	the	roles	will	rotate	
and	a	different	student	will	present	their	sketch	and	a	different	scribe	will	fill	out	the	sheet.	

• 	The	goal	is	for	each	artist	to	present	at	least	two	sketches	to	their	groups	before	the	end	of	
the	period.		So	it	is	best	to	cap	it	to	five	minutes	per	sketch.		We	do	not	recommend	having	
one	artist	present	all	their	sketches	at	once,	in	case	time	runs	out.				

	
Day	5		
1.		This	is	a	working	day.		Students	will	begin	to	create	in	Grapher/Desmos,	trying	to	make	their	sketch	

appear	on	the	screen.	
2.		Before	students	begin	it	is	important	to	cover	some	basics	about	how	to	save	their	work	as	well	as	

how	to	export	it	to	Photoshop.			
	 	 GRAPHER	

BORDER:	needed	for	adding	color	in	Photoshop.	
Format	->	Layout	->	Margins	->	1	cm	margin	around	the	piece		
GETTING	RID	OF	LINES	IN	BACKGROUND:	allows	art	to	be	uncluttered.	
Format	->	Axes	&	grids	->	unclick	cartesian		
EXPORTING	FILE:		allows	you	to	open	the	artwork	in	Photoshop	in	the	best	way.	
File	->	Export	->	File	Format	->	EPS	(seems	to	give	the	best	resolution)	
	 on	the	same	screen	before	clicking	okay	
	 -	make	sure	the	dpi	is	450	or	greater.	
	 -	make	sure	compression	is	all	the	way	to	the	right	for	better	quality	
DESMOS	
BORDER:	needed	for	adding	color	in	Photoshop.	(You	will	need	to	create	parametric	linear	
equations	that	border	your	art.)	
GETTING	RID	OF	LINES	IN	BACKGROUND:	allows	art	to	be	uncluttered.		Go	to	wrench	in	upper	
right	corner.		Unclick	Grad	and	Axis	for	a	white	background.	
EXPORTING	FILE:		allows	you	to	open	the	artwork	in	Photoshop	in	the	best	way.		In	top	black	bar:	
Share	Key>,Export	Image>Size	–	Large	Rectangle>Line	Thickness	-	Medium>Download	PNG.	

3.		Let	students	know	we	will	work	one	more	day	in	class	tomorrow	and	then	we	won't	come	back	to	the	
project	for	a	bit.	

	
Day	6			
1.		Students	continue	to	work	on	project.	
2.		Take	10	mins	or	so	to	show	them:	

-	how	to	open	a	saved	project	in	Photoshop	–	600	pixels	or	more	
-	how	to	save	from	Photoshop	–	Highest	Quality	
-	how	to	drop	in	color	–	paint	bucket	
-	how	to	enlarge	so	that	they	can	get	the	white	spaces	



3.		Remind	them	that	Google	can	help	them	do	just	about	anything	on	Grapher/Desmos	or	in	Photoshop.	
4.		Tell	students	we	will	only	have	one	more	day	in	class	to	work	on	project	together	and	all	other	work	

must	be	done	outside	of	class.	
	
Normally,	we	go	back	to	regular	chapter	work	at	this	point	for	a	few	days.	
	
Day	7			
1.		Working	day.	
	
Then	we	go	back	to	chapter	work	for	a	few	more	days	and	finally	we	have	presentations.		
	
Day	8-10	-	Presentations	
1.		Students	are	asked	to	do	a	5	-7	minute	presentation	that	includes:	

-	color	copy	on	8.5	by	11	cardstock	of	their	final	piece	
-	a	larger	projection	on	the	white	board	of	their	final	piece	
-	their	intent	
-	how	their	project	morphed	
-	the	math	they	used	
-	the	new	things	they	learned	
-	what	they	would	improve/do	differently	if	had	more	time	

2.		Basically,	we	want	them	to	share	their	process.	
3.		Some	students	do	PowerPoint	slides	that	show	their	work	in	progress.		Others	just	project	their	final	

piece.		Our	hope	is	that	the	above	isn't	a	list	that	students	check	off	as	they	talk	about	their	art,	but	
rather	that	it	helps	them	structure	their	journey.	

	
	(We	have	course	culmination	week	at	our	school	where	each	class	meets	for	two	hours.		Instead	of	an	
exam	during	this	time	we	do	presentations.		But	sometimes	we	need	to	back	the	presentations	back	into	
the	week	before	so	everyone	gets	the	appropriate	amount	of	time.)			
	
	
POSSIBLE	Adjustments	to	save	time:	
Move	Day	2	Video	to	homework	on	Day	1	and	discuss	project	handouts/overview	on	Day	1.	
Day	3	could	become	half	a	day	and	you	can	teach	half	the	day.	
Day	4	needs	to	stay	
Day	5	needs	to	stay	
Day	6		&		Day	7	could	happen	as	one	day	and	the	kids	do	the	work	outside	of	class.	
Presentations	could	be	just	showing	the	artwork	around	the	room.		Or	just	a	two	minute	each.		Or	no	
presentation	and	the	kids	just	turn	in	their	art	and	their	paper.		
	



	Honors	Algebra	2	Project	–	Student	Overview	
Mathematical	Art	inspired	by	Brigit	Riley	

	
During	the	course	of	this	project,	you	will	create	a	piece	of	artwork	using	two	computer	programs	-	
Grapher	and	Photoshop.		You	will	use	the	functions	that	you	have	studied	this	year	and	their	
transformations	to	create	an	original	piece	of	art	that	is	inspired	by	the	work	of	Brigit	Riley.		In	the	end,	
you	will	be	assessed	on	four	things	–	your	process,	final	piece	of	art,	a	written	piece,	and	a	class	
presentation	where	you	show	you	can	talk	about	the	mathematics	involved	in	your	project.		
	
Process		
I	will	observe:	

-	your	use	of	time	
-	your	collaboration	with	others	
-	your	tenacity/grit/perseverance	
-	your	trouble-shooting/problem-solving	strategies	

	
Artwork		
Your	piece	of	art	will	need	to:	

-	be	created	with	grapher	and	use	a	program	like	photoshop	to	add	color	
-	incorporate	the	three	tenets	of	Ms.	Riley's	work:	light,	depth,	movement	
-	be	printed	on	white	cardstock	in	full	color	
-	be	signed,	dated,	and	named	

	
Written	Piece		
Your	written	piece	should	include:	

- your	original	sketches	
- your	group's	critique/feedback	sheets	
- a	discussion	of	your	"artist's	intent"	(if	it	changed	from	the	original	sketch,	then	discuss	how	

that	happened	and	why)	
- a	list	of	equations	you	used	in	Grapher		
- a	discussion	of	your	process	as	you	worked	to	determine	what	was	needed	to	achieve	your	

intent	(including	what	transformations	were	needed)	
- a	discussion	of	any	math	you	"discovered"	or	learned	in	order	to	create	your	piece	
- a	discussion	of	what	you	would	do	differently	next	time,	or	what	you	would	do	to	improve	

your	project	if	you	had	more	time	
		
Class	Presentation	
You	will	have	3	to	5	minutes	to	present	your	final	piece	of	art	to	the	class.	
		

Most	of	all,	I	want	you	to	have	fun	-	recognizing	that	math	is	in	art	and	art	is	in	math!	
	
	
	



Desmos	Trial	for	Students	
	
Try	create	these	graphs	in	Desmos	using	only	the	number	of	equations	stated:	
	

1. 	Do	with	only	3	
equations	

	
	

2. 	
	 	Do	with	only	6	equations	

	
	



3. 	
	 	Do	with	only	3	equations	

	
	
	
	

4. 		
	 Do	with	only	2	equations	

	



	
	

Desmos	Trial	for	Students	-	Solutions	
	
Try	create	these	graphs	in	Desmos	using	only	the	number	of	equations	stated:	
	

1. 	Do	with	only	3	equations	
	
Solution:				 	𝑘 = 1,2, … 5 	on	line	1	
	 	 	𝑦 = 𝑘𝑥 + 𝑘			on	line	2	and		
	 	 	𝑦 = 𝑘𝑥 + 𝑘	on	line	3	
	
	
	
	
	

2. 	Do	with	only	6	equations	
	

Solution:		 𝑘 = 1,2, … 5 	on	line	1			

(𝑥 − ℎ)0 + (𝑦 − 2)0 = 1
0

0
		on	line	2	and	on	the	next	4	lines	change	the	value	in	the	y	

parenthesis	to	𝑦 − 1,	𝑦 − 0,	𝑦 + 1,	𝑦 + 2 

	 



	 

	

3. 	Do	with	only	4	equations	
	

Solution:		 𝑘 = −2,−1,…2 	on	line	1			

3
0

0
+ (𝑦 − 𝑘)0 = 1		on	line	2	and	on	the	next	2	lines	change	the	value	in	the	

denominator	of	the	x	parenthesis	to	4	and	then	6 

	
	
	
	

4. 	Do	with	only	2	equations	
	
	

Solution:		 ℎ = −10,−9,…10 	on	line	1			

𝑦 = 3
6
+ 6

7
		on	line	2	 



Students	Initial	Sketches	Critque	

Name	of	Presenter	______________________________________________	 	

Name	of	Notetaker	_____________________________________________	

Members	in	Group	________________________________________________________________	

	
1. Things	the	Artist	had	to	share	about	their	piece:	

	
	
	
	
	
	

2. Intent	that	the	artist	was	trying	to	portray:	
	
	
	
	

3. Warm	Comments	from	Group	members:	
	
	
	
	
	
	
	
	
	
	

4. “I	wonders”	from	all	group	members:	
	
	
	
	
	
	
	
	

5. Any	other	details/things	to	remember:	
	
	



Student	Brigit	Riley	Video	
YouTube	times	&	important	points	

	
Brigit	Riley	Part	1	

• https://www.youtube.com/watch?v=nnlBdZPO8lQ	
:42	to	1:14	–		 	 What	inspired	her?		
	
	
1:37	to	2:57	–		 talk	about	the	trials….	
	
	
5:14	to	5:38	–		 Who/what	guided	her	art?		

	
	

6:02	to	7:00	–		 What	does	she	say	about	rhythm	and	repetition?		
	
	
8:26	to	8:54	–		 Light?	
	
	
Brigit	Riley	Part	2	

• http://www.youtube.com/watch?v=uz7Vf4O7nQE&feature=relat
ed 

	
0	to	:42	–	 Listen	for	“shimmer.”	What	is	the	point?	
1:20	to	1:48	–	 What	does	the	eye	do?	
	
	
	2:32	to	3:05	–	 What	does	Brigit	say	about	color	as	light	vs.	real	light?		
	
	
	
4:00	to	5:42	–	 What	does	she	say	about	depth	and	color?	
	
	
7:20	to	9:47		–			 What	do	you	think	I	might	have	wanted	you	to	see	in	this	video?	
	
	
Brigit	Riley	Part	3	–	watch	if	you	have	time.	



Teacher	-	Brigit	Riley	
YouTube	times	&	important	points	

	
Brigit	Riley	Part	1	

• http://www.youtube.com/watch?v=Z1lQCTunGxg&feature=related 

	

:42	to	1:14	–		 she	talks	about	Cornish	countryside	-	light	

1:37	to	2:57	–		 narrator	talks	about	color	and	what	“looking”	feels	like	what	trials	will	

work	or	not	–	how	energy	is	created	

5:14	to	5:38	–		 says	who	guided	her	art	–	Seurat	and	

futurism	&	optical	sensation	of	movement	

6:02	to	7:00	–		 rhythm	and	repetition	talk	about	movement	by	Brigit	herself	–	alive	

rhythm	and	changing	pace	

8:26	to	8:54	–		 narrator	talks	–	shimmer	and	passing	of	light	

	

Brigit	Riley	Part	2	

• http://www.youtube.com/watch?v=uz7Vf4O7nQE&feature=related 

	

0	to	:42	–	 form	moves	on	an	axis	and	shimmers	in	space	

1:20	to	1:48	–	 eye	feels	movement	and	energy	

2:32	to	3:05	–	 Brigit	talking	about	color	as	light	vs.	real	light	and	how	to	use	color		-	

“seeing	it	is	when	the	painting	starts	to	live”	

4:00	to	5:42	–	 Brigit	talks	about	color	again	–	and	depth	of	distance	

7:20	to	9:47		–			 shows	how	she	works	with	others	and	makes	trials	

	



	
		 Mechanics	

Has	art	piece	printed	on	
cardstock	

4	pts											
clean,	sharp,	
signed,	dated	

3	pts																						
Has	3	of	the	4	
items	in	best	

2	pts																							
has	2	of	the	4	
items	in	best	

1	pt																							
has	1	of	the	4	
items	in	best	

0	pts																				
not	turned	in	

Has	written	report	
	4	pts											

addresses	all	
four	items	

	3	pts											
addresses	

three	of	four	
items	

	2	pts											
addresses	two	
of	four	items	

	1	pt											
addresses	one	
of	four	items	

	0	pts											
addresses	none	
of	four	items	

Has	original	sketches	 2	pts																																																				
has	both	sketches	

1	pt																																																							
has	one	sketch	

0	pts																																																
no	sketches	

Has	group	critiques	 2	pts																																															
has	both	critiques	

	1	pt																																																				
has	one	critique	

0	pts																									
no	critiques	

Has	list	of	equations	 2	pts																																																	
all	equations	are	present	

1	pt																																																						
some	equations	are	missing	

0	pts																							
no	equations	

Project	turned	in	on	time	 2	pts																																																						
ready	at	beginning	of	class	

1	pt																																								
assembling	project	in	class,	but	

complete	OR	1	day	late	

0	pts																					
2	or	more	days	

late	

		 Brigit	Riley	Components	

Depicts	movement	
4	pts																					
Clear		-		
pulsates	

3	pts																						
Clear		-	no	
pulse						

2	pts															
Hard	to	"feel"		

1	pt																					
very	little	
movement	

0	pts																			
No	Movement	

Depicts	depth	

4	pts																										
Uses	

equations	&	
color	-	clear	

3	pts																			
Uses	

equations	and	
color	-	less	
obvious																				

2	pts																		
Uses	

equations	OR	
color	clearly	

1	pt																						
Uses	

equations	or	
color	less	
obvious	

0	pts													
Little	or	no	

depth	
perceptible	

Uses	Color	as	Brigit	-	depth,	
movement,	afterimage,	light	

4	pts																							
For	all	4	items	

3	pts																	
For	3	of	4	
items																		

2	pts																
For	2	of	4	
items	

1	pt																						
For	1	of	4	
items	

0	pts																	
Unsuccessful	at	

all	four	

Intent	is	clear	in	art	piece,	
report,	presentation	

3	pts																																							
Clear	in	all	

areas	

2	pts																						
Clear	in	two	

areas	

1	pt																					
Clear	in	one	

area	

0	pts																																																											
No	idea	of	intent	

		 Mathematical	Components	

Includes	multiple	functions	
from	this	year	in	Non-trivial	

ways	

4	pts																			
Does	both	

3	pts														
Few	equations	
in	non-trivially	

2	pts																											
Few	equations	
Trivially	or	

one	equation	
nontrivially	

1	pt																													
Uses	1	
equation		

0	pts																								
Does	neither	

Equations	use	
transformations	

4	pts												
Many	Eqs	are	
transformed	

3	pts													
Several	Eqs	

are	
Transformed	

2	pts																							
Few	Eqs	are	
transformed	

1	pts																							
One	Eqs	is	
transformed	

0	pts																					
No	Eqs	are	
transformed	

Through	final	piece	(or	
conversations)	shows	an	

understanding	of	how	the	
transformations	work	

4	pts																	
Uses	in	

multiple	ways	

3	pts																			
Some	

confusion	
about	trans	

2	pts																		
uses	few	trans		

1	pt																
uses	few	trans	

&	very	
confused	

0	pts																							
No	

transformations	



Uses	variables	to	minimize	
number	of	equations	needed	

2	pts																																			
Condenses	Eqs	everywhere	

possible	

1	pt																																											
Condenses	Eqs	in	many	places	

0	pts																											
No	Eqs	with	
variable	

		 Problem	Solving	

Worked	on	project	outside	of	
class	

2	pts																																																
Progress	made	between	each	

class	

1pt																																																
Progress	made	between	most	

classes	

0	pts																
No		Progress	
btwn	classes	

Collaborated	with	Classmates	
2	pts																																					

Seen/Heard	on	Multiple	
equations	

1	pt																																		
Seen/heard	from	time	to	time	

0	pt																					
Worked	solo	

always	

Showed	tenacity/grit	when	
stuck	

3	pts																				
never	"gave	

up"	

2	pts											
sometimes	

asked	for	help	
first	

1	pt													
usually	asked	
for	help	first	

0	pts	always	asked	for	help	
immediately	

		 Presentation	

Clearly	prepared	for	
Presentation	

2pts																																																					
has	sketch	or	materials,	

presentation	flows	smoothly	

1	pt																																																		
has	materials,	presentation	has	

a	few	bumps	

0	pts							
Unprepared	

Had	a	focus/purpose	(related	
to	project?)	

2	pts																																																	
Clear	"thesis"	to	presentation	

1	pt																																	
Presentation	"thesis"	a	bit	

"fuzzy"	

0	pts																				
no	"thesis"	-	
rambles	

Overall	
4	pts																				

1	of	Best	
Project	Ever	

3	pts										
Really	great	
project	

2	pts												
Good	project	

1	pt													
Okay	project	

0	pts										
Seems	thrown	

together	

TOTAL	(60	points	possible):	 		

	
Comments:	
	
	

	      

	
	


